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Section 5  
 

Controlling a Presentation 

By the end of this Section you should be able to: 

Change Slide Order 
Delete and Hide Slides 
Create Action Buttons 

Use Hyperlinks 
Use Preset and Custom Animation 

Animate Charts 
Set up a Slide Show 

Apply Slide Transitions and Timings 
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Exercise 36 - Changing Slide Order 

Guidelines: 

To make a presentation flow more smoothly you may want to change the order of 
some of the slides. Slide Sorter View allows you to do this. 

Actions: 

1. Open the Adventure presentation (or Adventure Data3 from the data 
files), close the Task Pane and switch to Slide Sorter View. 

2. Click the arrow to the right of the Zoom box, , on the Standard 
Toolbar, and select a zoom value of 75%. 

3. Scroll down so that slides 7 - 12 are visible on the screen. 

4. Slide 11, Holiday Costs should come after Slide 8, Book Early. Click on 
Slide 11 and hold down the mouse button. 

5. Drag the slide towards Slide 8 and a grey line appears as it is moved. 

 

6. When the grey line is between Slide 8 and Slide 9, release the mouse. The 
Holiday Costs slide is now Slide 9. 

7. Save the presentation and leave it open. 
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Exercise 37 - Deleting Slides 

Guidelines: 

Slides that are no longer required can be deleted. The easiest way to do this is to 
use Slide Sorter View. 

Actions: 

1. In Slide Sorter View, click between Slides 1 and 2 and select Insert | New 
Slide. 

2. Use the Title and Text format. 

3. Switch to Normal View and enter the title About Us. 

4. Click to add the following text: The company was established in 1989. 

5. On the next line enter One of the Directors is ex- SAS. 

 
6. The Director in question has come in to see how the presentation is 

progressing. He is not happy about the new slide, as he thinks he may be 
traced and targeted by certain groups. You must delete the slide. Switch to 
Slide Sorter View. 

7. Select the slide and then select Edit | Delete Slide. 

8. The Clip Art slide (Slide 13) is not really part of the presentation. Select 
that slide in Slide Sorter View and press <Delete>. 

9. Save the presentation and leave it open. 
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Exercise 38 - Hiding Slides 

Guidelines: 

Occasionally a presentation may have slides that contain sensitive information. If 
necessary these can be hidden. 

Actions: 

1. The Director is still not happy with the presentation. Make sure you are in 
Slide Sorter View. 

2. He thinks the slide about accidents should be hidden. Select Slide 7. 

3. From the Slide Sorter toolbar click Hide Slide, . A symbol appears 
beneath the slide to indicate that it will be hidden during the slide show. 

 

4. Select Slide 1 and view the slide show, clicking on each slide to advance to 
the next. 

5. Notice how Slide 7 does not appear. 

6. Save the presentation and leave it open. 



Emyr Brown   Ysgol BrynTeg  Powerpoint Help 

© CiA Training Ltd 2005 5  Emyr Brown Ysgol BrynTeg 2009
  

Exercise 39 - Hyperlinks and Action Buttons 

Guidelines: 

Regular users of the Internet will be familiar with Hyperlinks - text or images that 
move the user directly to another location when they are clicked on. Hyperlinks to 
other slides in a presentation, to locations on an Intranet or the Internet can all be 
created on slides. Action buttons are often used to create hyperlinks in a 
presentation. They allow rapid, easy navigation between slides. 

Actions: 

1. View Slide 2 of the Adventure presentation in Normal View. 

2. Highlight the text Walking Safaris and select Insert | Hyperlink. 

3. From the Insert Hyperlink dialog box click the Place in This Document 
button in  the left panel then select 6. Walking Safaris from the list of slide 
titles. 

 
4. Click OK to create the hyperlink. The colour of the hyperlink text on the 

slide is different to other text. When the hyperlink destination has been 
visited, the text colour will change again. 

5. To test the hyperlink click the Slide Show button, , at the lower left of 
the screen with slide 2 still selected. 

6. Click on the hyperlink text, Walking Safaris. Instead of moving to slide 3, 
the next slide to appear will be slide 6. 

7. Press <Esc> to end the slide show. Slide 6 should be shown in Normal 
View. 

8. To add an Action Button, click the AutoShapes button, , then 

Action Buttons and finally select the Forward or Next action button, . 

continued over 



Emyr Brown  Ysgol BrynTeg  PowerPoint Help 

© CiA Training Ltd 2005 6  Emyr Brown Ysgol BrynTeg 2009
  

Exercise 39 - Continued 

9. Click and drag the shape of the button at the bottom centre of the slide. 

Note: If a message appears about saving the presentation, select Yes. 

10. The Action Settings dialog box then appears on the screen. Ensure that 
the Mouse Click tab is selected. Click the Hyperlink to option and from 
the drop down list, select Slide, then from the list of slides displayed, select 
slide (7) Accidents… (the hidden slide).  

 

11.  Click OK, then OK again. 

12. When back in Normal View, click the Slide Show button to see the slide 
as it will appear in the presentation. An example is shown below. 

 

13. Click the action button. 

14. The presentation moves to slide 7, the Accidents slide, even though it is 
hidden and would not be displayed as part of a normal slide show.  

15. Exit the slide show and move to the next exercise. 
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Exercise 40 - Using Animation Schemes 

Guidelines: 

Animation can be applied to text and objects on a slide so they are brought on to  
the slide in a variety of different ways, e.g. fly from top, dissolve, etc. Animation 
can be applied in 3 areas: Slide Transition (how does the slide come into the 
presentation), Title Animation (how does the title appear on the screen) and 
Body Animation (how does the rest of the slide appear). These effects are also 
known as builds. 

Several preset schemes are available within PowerPoint that apply various 
effects within the 3 areas described above. These can be used without having to 
become involved in the more complex process of defining individual effects. 

Actions: 

1. Display slide 2 of the Adventure presentation in Normal View. 

2. Select Slide Show | Animation Schemes to display the Animation 
Schemes view of the Slide Design Task Pane. 

3. Make sure the Autopreview, at the bottom of the Task Pane, is selected 
so that any scheme is demonstrated immediately in the Slide pane. 

4. In the Task Pane list of Animation Schemes find 
Wipe and leave the pointer over the entry. A tool tip 
appears indicating the effects included in this Scheme. 

5. Click Wipe and the effects will be previewed. All effects 
are shown automatically, regardless of how they are to be triggered. 

6. Click the Slide Show button,  , in the Task Pane to see how 
the slide will actually appear. The slide appears full screen, the Title Fades 
in, but the text will not Wipe from the left until the mouse is clicked. Click 
with the mouse to bring in each line of text then press <Esc> to return to 
Normal View. 

7. With Slide 2 displayed, select the Unfold scheme. This has a Slide 
Transition (Push Right), a Title effect (Fly In) and a Body effect (Unfold). 

8. Click Slide Show to see how the presentation looks. Remember to click 
with the mouse where necessary to trigger the next animated text item. 

Note: Animation properties such as triggers, timings and sound are included in some 
schemes but can only be amended by using the Custom Animation feature. 

9. Press <Esc> to end the show. 

10. Close the Slide Design Task Pane. 

11. Save the presentation and leave it open for the next exercise. 
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Exercise 41 - Using Custom Animation 

Guidelines: 

Custom animation allows effects for individual items on a slide to be defined 
separately. Effects can be chosen from 4 areas. Entrance effects (how an item 
comes on to the screen), Emphasis effects (what it does on the screen), Exit 
effects (how an item disappears), and Motion Paths (to move an item around a 
slide). 

Customising also allows greater control over details within effects, such as the 
timing, speed and order of the animations, and any accompanying sound. For 
any selected effect, all the options can be set from a dialog box with 3 tabs. 

The Effects tab controls the addition of sounds, what happens to the item after 
animation and whether to introduce text all at once, word by word or letter by 
letter. 

The Timing tab controls when an effect is activated - on the click of the mouse or 
automatically, how fast the effect runs and whether it repeats. 

The Text Animation tab controls how the effects are applied to a bulleted text list 
(either to the whole list or by heading/subheading). 

Actions: 

1. Display slide 3, Free Fall Parachuting, in Normal View and select Slide 
Show | Custom Animation to display the Custom Animation Task Pane. 

2. Click on the slide Title area then click the  button in the Task 
Pane. 

3. Select , then select the Spiral In effect. If this effect is not 
on the first list, click More Effects, select the effect from the larger list and 
click OK. 

4. An entry is made, , in the Animation list for this 

slide. Click  to demonstrate the effect and note that it only applies 
to the title text. 

5. Once entered, the effect can be edited. Select the effect in the Animation 
list then click the drop down arrow to the right and select Effect Options.  

6. Select the Effect tab from the Spiral In dialog box. 

 
 

continued over 
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Exercise 41 - Continued 

7. Click in the After animation box 
and select More Colors. Choose a 
dark red colour and click OK. 

8. Click in the Sound box and select 
a suitable sound to accompany the 
effect. 

9. Click OK to apply the amended 
effect. Notice that the title text now 
changes colour after appearing 

10. Different effects can be applied to 
other parts of the slide. Select the main text area. 

11. Select Add Effect, then Entrance and apply the effect Float. A new item 
appears in the Animation list. 

 
12. Click the drop down arrow for the new effect and select Effect Options. 

13. Select the Text Animation tab from the Float dialog box. 

14. Change the Group text option to As one object and click OK to view the 
effect. 

15. Select Effect Options for this effect again. 

16. Select the Text Animation tab and change the Group text option back to 
By 1st level paragraphs. 

17. Select the Timing tab and change the Speed option to 2 seconds 
(Medium). 

18. Select the Effect tab and change the Animate text option to By Word. On 
the same screen, click in the Sound box and select a suitable sound. 

19. Click OK to apply all these options and view the results. Click Play to 
repeat the preview if required. 

20. Click  to see how the effects will appear in an actual 
presentation. Remember, mouse clicks will probably be required to trigger 
most of the effects and <Esc> can be pressed to terminate the show. 

21. Experiment by trying out some of the different settings within Effects 

Options, and use  to demonstrate the effects. 

22. Save the presentation and leave it open. 
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Exercise 42 - Animating Charts 

Guidelines: 

Preset Animation Schemes do not apply to inserted objects such as charts but 
custom animation can be applied. Animation can be applied to the chart as a 
whole or to individual elements separately. Available options include: 

 How to introduce the chart elements 

 Whether or not to animate the grid and legend  

 Which animation effect and accompanying sound are applied 

 What to do with the chart after it has been animated 

Actions: 

1. View slide 7, Accidents, in Normal View. Select the chart by clicking on it 
once. 

2. Select Slide Show | Custom Animation to display the Custom Animation 
Task Pane. 

3. Click , then  and finally select Dissolve In. 

Note: If Dissolve In is not on the list, click More Effects, select the effect and click OK. 

4. By default the animation is applied to the whole chart, as shown by the 

preview. Click  to demonstrate the effect again. 

5. Click the arrow to the right of the Chart entry (this may be listed as Chart 
2) in the Animation list and select Effect Options. 

 
continued over 
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Exercise 42 - Continued 

6. Select the Chart Animation tab and display the Group chart drop down 
list.  

 

7. Select By category and make sure Animate Grid and Legend is checked. 
Click OK to apply the animation. 

8. Click  to demonstrate the effect. 

9. The slide title should appear. Click once to see the chart background and 
legend dissolve in. Click again to display the data for the first category, 
Parachuting. The next three clicks will display the data for the 
Snowboarding, Rafting and Safari categories. 

10. Press <Esc> to end the slide show. 

11. Close the Custom Animation Task Pane. 

12. Save the presentation and leave it open. 
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Exercise 43 - Setting Up a Slide Show 

Guidelines: 

The two most common reasons for creating a presentation are to create a slide 
show and to produce printed handouts. The slide show can be printed out as 
actual slides, projected from the computer on to a screen (with the appropriate 
equipment), shown on the Internet or as a show on the computer screen itself. 
The following exercises demonstrate how to set up the show, with transitions and 
timings, etc. 

Actions: 

1. Switch to Slide Sorter View. 

2. Select Slide Show | Set up Show.  The Set Up Show dialog box appears. 

3. Make sure the dialog box shows All Slides and Advance slides Manually.  

 
4. Click OK. 

5. Select the first slide and then select Slide Show | View Show. 

6. The first slide in the presentation appears.  Notice the information at the 
bottom of the slide from the Slide Master. 

7. Click the mouse to move to the second slide. 

8. Move through the rest of the slide show, using the action button on Slide 6 
to navigate to the hidden slide. Ignore the hyperlink on slide 2. 

9. At the end of the show PowerPoint returns to Slide Sorter View. Leave the 
presentation open. 
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Exercise 44 - Applying Slide Transitions 

Guidelines: 

To add interest to a slide show, a transition can be applied to slides. This is a 
special effect, which controls how one slide changes to the next. 

Actions: 

1. In Slide Sorter View, select the Title slide (first slide) of the presentation. 

2. Click the Slide Transition button, . The Slide Transition Task 
Pane appears. 

 

3. Select some of the effects from the list and watch the previews. 

4. Select the effect Dissolve, and a speed of Medium. Select a sound if 
required and set Advance slide to On mouse click, then click Apply to 
All. The Dissolve transition effect is now applied to each slide in the 
presentation. 

Note: If Apply to All Slides is not selected the transition effect will be applied to the 
selected slide only. Different effects could be applied to different slides. 

5. Save the presentation. 

6. Select the first slide, then click the Slide Show button to run the slide show. 
Click the mouse button to move through. Notice the effects as the slides 
change. 

7. Leave the presentation open for the next exercise. 
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Exercise 45 - Applying Timings 

Guidelines: 

Slide shows can have timings applied to them, so that slides advance 
automatically without the need to use the mouse. If a presentation is run 
automatically, it can be viewed without the need for a presenter. 

Note: If a presentation contains hyperlinks and action buttons it should really be run 
manually, but for this presentation you will apply timings. 

Actions: 

1. With the Adventure presentation in Slide Sorter View, select the first slide 

and then the Rehearse Timings button, . The slide show begins, with 
the Rehearsal dialog box on the screen. 

 

2. After a few seconds, click the Next button, . The next screen appears 
with the time for the current slide reset. 

3. Pause the rehearsal using the Pause button, , then restart it using the 
same button. 

4. Move to the next slide/effect. 

5. View the entire presentation, clicking the Next button after a few seconds of 
each slide until finished. 

Note: Remember that the bulleted lists will require a click of the mouse for each line to 
appear and you will need to click the Action Button hyperlink on Slide 6 to view 
the hidden Slide 7 so it will be included in the timings. 

6. At the end of the rehearsal a dialog box appears showing the total time for 
the slide show and asking if the timings are to be saved for future use. 
Select Yes. 

Note: Timings can be changed from the Slide Transition Task Pane. For example, to 
change the time for all slides to 15 seconds, from Advance slides, select 
Automatically after and use the up/down spinner to display 00:15 in the box. 
Click the Apply to All Slides button. 

7. Notice how the times for each slide are now shown underneath the slides, 
as in the diagram on the next page. The symbols next to the timings 
indicate that there is some form of animation applied to that slide. 

continued over 

Total time elapsed 

Time elapsed for this slide Pause 

Next 

Repeat 
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Exercise 45 - Continued 

 

Note: The total time for the slide show is made up of the times for each individual slide. 
The timing can be changed at any time by clicking the Rehearse Timings button 
again. 

8. Select Slide Show | Set Up Show. In the Set Up Show dialog box, make 
sure Advance slides, Using timings, if present is selected. 

 

Note: If required, there is an option available from Slide Show | Set up Show, which 
will allow the show to run continuously until <Esc> is pressed. 

 

9. Click OK, then save the presentation. 

10. View the slide show. The slide show will now play, when activated, using 
the timings set in the rehearsal, without any manual intervention required. 

Note: Normally there would be no need to press the mouse button at all. However, 
because Slide 7 is hidden, you will only be able to view it by clicking the action 
button hyperlink immediately after the text has appeared on Slide 6. This is why 
presentations including hyperlinks are best run manually. 

11. Close the presentation. 
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Exercise 46 - Revision 

1. Open the presentation Induction, saved in Exercise 35. 

2. Move Slide 4 Bright Future before Slide 3 Company Performance. 

3. Delete the new Slide 4 Company Performance. 

4. Create an action button hyperlink on Slide 2 Company Structure to go to 
Slide 3 Bright Future. 

5. Hide Slide 3 Bright Future. 

6. Apply a single animation effect to all slides. 

7. Apply a single transition effect to all slides. 

8. Apply timings to the presentation. 

9. Set the show up to advance using timings. 

10. Save the presentation. 

11. View the slide show. 

12. Close the presentation. 
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Section 6 
 

Finishing and Printing 

By the end of this Section you should be able to: 

Add Speaker’s Notes 
Create Start and End Slides 

Print Slides and Presentations 
Print in Portrait and Landscape 

Produce Evidence of Timings and Effects 
Print Handouts 
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Exercise 47 - Adding Speaker’s Notes 

Guidelines: 

Notes can be added to any or all slides in a presentation. The notes can be to 
prompt the speaker as he or she runs the slide show, or for the benefit of the 
audience. Notes can be printed separately, to be handed out to the audience if 
required. 

Actions: 

1. Open the Adventure presentation (or Adventure Data4 from the data 
files). 

2. Select Slide 6 Walking Safaris and select View | Notes Page. 

 

3. Click in the white area beneath the slide and zoom in to 100%. 

4. Type in the following note for the speaker: 

The next slide is hidden as it contains information about accidents 
that occurred last year. Use discretion when showing this slide, 
depending upon your audience. 

5. Click the Next Slide button, , at the far right of the slide to move to Slide 
7. 

6. Add the following note: 

Stress the fact that most accidents were not serious, but we do have a 
duty to let customers know the risks involved before they book a 
holiday. 

7. Save the presentation and switch to Slide Sorter View. 
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Exercise 48 - Start and End Slides 

Guidelines: 

It is good practice to make sure the audience can clearly see the start and end of 
a presentation. The start is usually defined by using a Title Slide, as you have 
done in the current presentation. Sometimes a blank slide is used to indicate the 
end of a presentation. 

Actions: 

1. The Adventure presentation should be open in Slide Sorter View. It 
already has a Title Slide as Slide 1. Select the last slide, Slide 12. 

2. Insert a new slide, choosing the Blank layout from the Content Layouts in 
the Slide Layout Task Pane. 

 

3. Notice that the graphic and footer information still appear on this slide, as 
they were added in Slide Master View. 

4. Save the presentation. 

5. Leave the presentation open. 
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Exercise 49 - Page Setup 

Guidelines: 

Various elements of a presentation can be printed. Before printing you may need 
to change the orientation of the slides or the notes pages/handouts, i.e. from 
Portrait to Landscape. 

Actions: 

1. In Slide Sorter View, select File | Page Setup. 

2. The Orientation area is at the right of the dialog box. Select Portrait from 
the Slides area. 

 

3. Click OK and notice the change to the layout of the slides. 

4. Change the slide orientation back to Landscape. 

Note: Orientation can be changed for notes pages and handouts too. 

5. Save the presentation. 
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Exercise 50 - Printing Slides and Presentations 

Guidelines: 

Slides, notes pages, outlines and handouts can be printed in various formats.  

Actions: 

1. In Slide Sorter View, select the second slide and select File | Print. The 
Print dialog box appears. 

 
2. Check that the printer is ready to print. If the printer name shown is 

incorrect, click on the Printer Name drop down arrow and select the correct 
one. 

3. From Print range, choose Current slide. Make sure the Copies area 
shows 1, then click OK to print Slide 2 only. 

4. Select File | Print again. To print a range of slides, select Slides from Print 
range and enter 3, 6-8 in the box provided. 

5. Click OK to print slides 3, 6, 7 and 8. 

6. To print the speaker’s notes created earlier, select File | Print. 

7. From Print what select Notes Pages and click OK. 

8. Leave the presentation open for the next exercise. 
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Exercise 51 - Show Timings and Effects 

Guidelines: 

A screen print of a presentation can be obtained to show that you have applied 
timings, animation effects and transitions to slides. This may be used to provide 
evidence to someone who may not be able to view the presentation and forms 
part of the assessment. 

Actions: 

1. Switch to Slide Sorter View, close any open Task Pane and change the 
zoom to 50%. 

2. Press the <Print Screen> key on your keyboard. 

3. Start Word XP by selecting Start | Programs | Microsoft Word. 

4. Click the Paste button, . An example of the screen is shown below. 

 

5. Click Print, . 

6. Select File | Exit to close Word and select No when prompted to save. 

7. Leave the presentation open. 
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Exercise 52 - Printing Handouts or Thumbnails 

Guidelines: 

Handouts can be printed for an audience to follow as the presentation is running. 
Later they can use them for reference to remind them of the presentation.  They 
have several slides on one printed sheet, in miniature. 

Actions: 

1. In Slide Sorter View, select File | Print. 

2. From the Print what drop down list, select Handouts. 

3. Drop down the list next to Slides per page and select 3. 

 

4. The small preview at the right of this section shows how the print out will 
appear. Click OK to print the handouts. 

5. Select File | Print again. This time select to print 9 handouts per page. 

6. Click OK. 

7. Notice how small the slides appear in comparison with the previous 
handout. This is where the name thumbnails comes from. 

8. Save the presentation and close it. 
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Exercise 53 - Revision 

1. Open the presentation Induction, saved in Exercise 46. 

2. Add the following speaker’s note to Slide 3 Bright Future: Mention the 
preliminary figures for this year, showing Turnover and Profit growing 
faster than ever. 

3. Create a blank slide to end the presentation. 

4. Print the speaker’s notes in landscape orientation. 

5. Print an outline showing only the titles of the slides. 

6. Print handouts, 9 to a page. 

7. Obtain a screen print to evidence the effects applied. 

8. Close Word. 

9. Save the presentation and close it. 

10. Close PowerPoint. 
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Answers 
Exercise 12 - Revision 

 

Exercise 22 

 

Exercise 23 - Revision 
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Exercise 34 

 

Exercise 35 - Revision 
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Glossary 
Alignment The arrangement of text or objects in relation to the slide 

or text box, e.g. left, centre, right, top, bottom. 

Animation Special effects which make text and other objects appear 
to move on screen. 

Animation Scheme A collection of animation effects which can be applied to a 
slide with a single selection. 

Background The colour or graphic behind the contents of the slide. 

Bullet Levels Used to emphasise major and minor points. 

Copy Create a duplicate of an object or text. Used when the 
copied item is to be duplicated. 

Custom Animation Applying animation effects to individual objects on a slide 
and specifying their operation. 

Cut Remove an object or text. Used when the cut item is to be 
moved somewhere else. 

Footer Text or numbers appearing at the bottom of the slide, 
notes page or handout. 

Formatting Changing the appearance of text, graphics, etc. 

Header Text or numbers appearing at the top of the slide, notes 
page or handout. 

Import Bring a file into a presentation from another application. 

Object Item on a slide, e.g. drawn shape, image, chart, text box. 

Orientation Which way up the slide/handout is: Portrait or 
Landscape. 

Paste Used after Cut or Copy to position the item (move or 
duplicate). 

Presentation A collection of slides used by a speaker as a visual aid. 

Slide Layout The type of slide, e.g. Title and Text, Title Only, etc. 

Slide Master This view is for adding items that are to appear on all 
slides in a presentation. 

Slides Make up the presentation, each refers to a specific area. 

Slide Show A preview of the presentation, with all effects, sounds, etc. 

Text Effects Formatting such as bold, italic, shadow, superscript. 

Timings Govern how long an item or slide remains on screen 
during a show. 

Transition How one slide moves to the next. 

Views Different ways of looking at slides. 


